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Safety Notice

Read all product manuals and consult with Beckman Coulter-trained personnel before attempting 
to operate the instrument. Do not attempt to perform any procedure before carefully reading all 
instructions. Always follow product labeling and manufacturer’s recommendations. If in doubt as 
to how to proceed in any situation, contact your Beckman Coulter Representative.

Alerts for Danger, Warning, Caution, Important, and Note

DANGER

DANGER indicates an imminently hazardous situation which, if not avoided, will 
result in death or serious injury. This signal word is to be limited to the most 
extreme situations.

WARNING

WARNING indicates a potentially hazardous situation which, if not avoided, could 
result in death or serious injury. May be used to indicate the possibility of 
erroneous data that could result in an incorrect diagnosis (does not apply to all 
products).

CAUTION

CAUTION indicates a potentially hazardous situation, which, if not avoided, may 
result in minor or moderate injury. It may also be used to alert against unsafe 
practices. May be used to indicate the possibility of erroneous data that could 
result in an incorrect diagnosis (does not apply to all products).

IMPORTANT IMPORTANT is used for comments that add value to the step or procedure being performed. 
Following the advice in the Important adds benefit to the performance of a piece of equipment or to a 
process.

NOTE NOTE is used to call attention to notable information that should be followed during installation, use, 
or servicing of this equipment.

Safety During Installation and/or Maintenance

This instrument is designed to be installed by a Beckman Coulter Field Service representative. 
Installation by anyone other than authorized Beckman Coulter personnel invalidates any warranty 
covering the instrument. Also, if the instrument needs to be moved, a Beckman Coulter Field Service 
representative must reinstall and relevel the instrument in its new location.

Any servicing of this equipment that requires removal of any covers can expose parts which involve 
the risk of electric shock or personal injury. Make sure that the power switch is turned off an the 
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Safety Notice
Electrical Safety 
instrument is disconnected from the main power source, and refer such servicing to qualified 
personnel.

Do not replace any ultracentrifuge components with parts not specified for use on this instrument.

Electrical Safety

To reduce the risk of electrical shock, this instrument uses a three-wire electrical cord and plug to 
connect this equipment to earth-ground. Make sure that the matching wall outlet receptacle is 
property wired and earth-grounded.

Do not place containers holding liquid on or near the chamber door. If they spill, liquid may get into 
the instrument and damage electrical or mechanical components.

Safety Against Risk of Fire

Fuses protect certain electrical circuits within this instrument against overcurrent conditions. For 
conditioned protection against the risk of fire, replace only with the same type and rating specified.

This instrument is not designed for use with materials capable of developing flammable or 
explosive vapors. Do not centrifuge such materials (for example, chloroform or ethyl alcohol) in this 
instrument nor handle or store them near the centrifuge.

Mechanical Safety

For safe operation of the equipment, observe the following:

 • Use only the Beckman Coulter rotors and accessories designed for use in this instrument.

 • Do not exceed the maximum rated speed of the rotor in use.

 • NEVER attempt to slow or stop a rotor by hand.

 • Do not move the ultracentrifuge while the drive motor is spinning.

 • In the event of a power failure, do not attempt to retrieve the sample from the instrument for 
at least one hour. Then follow the instructions for recovery of the sample under CHAPTER 6, 
Troubleshooting.

Chemical and Biological Safety

Normal operation may involve the use of solutions and test samples that are pathogenic, toxic, or 
radioactive. Such materials should not be used in this instrument, however, unless all necessary 
safety precautions are taken.
PN LXP-IM-7iv



Safety Notice
Chemical and Biological Safety
WARNING

Normal operation may involve the use of solutions and test samples that are 
pathogenic, toxic, or radioactive. Handle body fluids with care because they can 
transmit disease. No known test offers complete assurance that they are free of 
micro-organisms. Some of the most virulent—Hepatitis (B and C) and HIV (I–V) 
viruses, atypical mycobacteria, and certain systemic fungi—further emphasize the 
need for aerosol protection. Handle other infectious samples according to good 
laboratory procedures and methods to prevent spread of disease. Because spills 
may generate aerosols, observe proper safety precautions for aerosol 
containment. Do not run toxic, pathogenic, or radioactive materials in this 
ultracentrifuge without taking appropriate safety precautions. Biosafe 
containment should be used when Risk Group II materials (as identified in the 
World Health Organization Laboratory Biosafety Manual are handled; materials of 
a higher group require more than one level of protection.

WARNING

Do not use the ultracentrifuge in the vicinity of flammable liquids or vapors, and 
do not run such materials in the instrument. Do not lean on the instrument or 
place items on it while it is operating.

It is your responsibility to decontaminate the instrument and accessories before requesting service 
by Beckman Coulter Field Service.
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Introduction

Certification

To ensure full system quality, Beckman Coulter Optima™ L-XP series ultracentrifuges have been 
manufactured in a registered ISO 9001 or 13485 facility. They have been designed and tested to be 
compliant (when used with Beckman Coulter rotors) with the laboratory equipment requirements 
of applicable regulatory agencies. Declarations of conformity and certificates of compliance are 
available at www.beckmancoulter.com.

Scope of Manual

This manual is designed to familiarize you with the Optima™ L-XP series ultracentrifuge, its 
functions, specifications, operation, and routine operator care and maintenance. We recommend 
that you read this entire manual, especially the Safety Notice and all safety-related information, 
before operating the ultracentrifuge or performing instrument maintenance.

 • CHAPTER 1, Description contains system specifications and a brief physical and functional 
description of the ultracentrifuge, including the operating controls and indicators.

 • CHAPTER 2, Preinstallation Requirements provides information about space and power 
requirements for installing and connecting the ultracentrifuge.

 • CHAPTER 3, Operation contains ultracentrifuge operating procedures.

 • CHAPTER 4, Simulations describes the use of the run simulation features.

 • CHAPTER 5, Reference and Log Functions provides information about reference and log functions 
of the ultracentrifuge.

 • CHAPTER 6, Troubleshooting lists possible malfunctions, together with probable causes and 
suggested corrective actions.

 • CHAPTER 7, Maintenance contains procedures for routine operator care and maintenance, as 
well as a brief list of supplies and replacement parts.
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Introduction
CFC-Free Contrifugation 
NOTE If the ultracentrifuge is used in a manner other than specified in this manual, the safety and 
performance of this equipment could be impaired. Further, the use of any equipment other than that 
recommended by Beckman Coulter has not been evaluated for safety. Use of any equipment not 
specifically recommended in this manual and/or the appropriate rotor manual is the sole responsibility of 
the user.

CFC-Free Contrifugation

To ensure minimal environmental impact, no CFCs are used in the manufacture or operation of the 
Optima™ L-XP ultracentrifuge.

Radio Interference

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with this instruction manual, may cause interference to radio communications. 
Operation of this equipment in a residential area is likely to cause interference, in which case the 
user will be required to correct the interference at his or her own expense.

Canadian Regulations

This equipment does not exceed the Class A limits for radio noise emissions from digital apparatus 
as set out in the radio interference regulations of the Canadian Department of Communications.

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites 
applicables aux appareils numériques de Classe A prescrites dans le reglement sur le brouillage 
radioelectrique édicté par le Ministère des Communications du Canada.
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Introduction
Recycling Label
Recycling Label

NOTE On the instrument, the triangle background is yellow rather than gray.

This symbol is required in accordance with the Waste Electrical and Electronic Equipment (WEEE) 
Directive of the European Union. The presence of this marking on the product indicates:

1. the device was put on the European market after August 13, 2005 and

2. the device is not to be disposed via the municipal waste collection system of any member state 
of the European Union.

It is very important that customers understand and follow all laws regarding the proper 
decontamination and safe disposal of electrical equipment. For Beckman Coulter products bearing 
this label please contact your dealer or local Beckman Coulter office for details on the take back 
program that will facilitate the proper collection, treatment, recovery, recycling and safe disposal 
of the device.

Software Copyright

The Optima™ L-XP eXPert operating software (a Microsoft* Windows-based computer program) is 
protected by international copyright laws. Unauthorized copying, use, distribution, transfer, or sale 
is a violation of those laws that may result in civil or criminal penalties. This computer program is 
also subject to additional restrictions contained in the following Microsoft OEM Customer License 
Agreement for Embedded Systems:

“If you use the Device to access or utilize the services or functionality of Microsoft Windows XP 
Server (all editions), or use the Device to permit workstation or computing devices to access or 
utilize the services or functionality of Microsoft Windows XP Server, you may be required to obtain 
a Client Access License for the Device and/or each such workstation or computing device. Please 
refer to the End-User License Agreement for Microsoft Windows XP Server for additional 
information.”

(The End-User License Agreement is available is available on the Microsoft Embedded Systems 

Web site.)

* Microsoft and Windows are registered trademarks of Microsoft Corporation.
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CHAPTER 1

Description

Instrument Function

The Optima™ L-XP ultracentrifuge is used to generate centrifugal forces for the separation of 
particles. The Optima™ L-100XP has a maximum rotational speed of 100 000 rpm; the L-80XP runs 
up to 80 000 rpm. Classified S, it can be used with all currently manufactured Beckman Coulter 
preparative rotors.

The microprocessor-controlled Optima™ L-XP provides an interactive operator interface, using a 
touchscreen and keypad, with the eXPert operating software.

Both manual and programmed operation are available. In manual operation, you enter the 
individual run parameters and begin the run. In programmed operation, you can create, save, recall, 
modify, and/or print a program, and then automatically run the ultracentrifuge via the program. 
Several advanced capabilities simplify laboratory ultracentrifugation, such as:

 • Setting up a run by specifying RCF (relative centrifugal force), ω2t (accumulated centrifugal 
effect), substitute rotor and tube combination, or sedimentation coefficient

 • Performing various centrifugation-related calculations, including pelleting time, 
concentration measures, refractive index, speed reduction, and sedimentation coefficient

 • ESP™ (Efficient Sedimentation Program), a simulation that provides optimum run times using 
precipitating and non-precipitating media

 • Rotor and tube catalogs containing pertinent information about Beckman Coulter 
ultracentrifuge rotors and tubes

 • A rotor library for tracking the rotors in your lab

 • Run logs for record-keeping or lab procedures purposes

 • Information on compatibility between centrifugation accessories and a variety of chemicals

To enable printing of run parameters, program settings, and/or simulations, a parallel port on the 
back of the instrument control head allows connection to a printer. See CHAPTER 2, Preinstallation 
Requirements for printer availability and hookup procedures.
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Description
Power 
Power

A circuit breaker, labeled I (on) and O (off), is located on the right side panel of the Optima™ L-XP 
and controls the electrical power to the instrument. Power should be left on, except in the case of 
an emergency or when maintenance is required.

A red POWER OFF button is located on the base of the control head for emergency shut-down (see 
Figure 1.1). Pressing the POWER OFF button trips the circuit breaker to the off position. To return 
power to the instrument, the circuit breaker must be returned to the up position.

Figure 1.1  Optima L-XP Control Head

Key Switch Positions

A key interlock switch is used to select normal, locked, or zonal operation (see Figure 1.2). Use the 
normal position for routine closed-door centrifugation, the locked position to prevent settings 
being changed during the run, and the zonal position for runs in which a zonal rotor is loaded and 
unloaded while spinning. (The key cannot be removed while in the zonal position.)

Figure 1.2  Key Switch Positions
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Description
Control Panel 1
Control Panel

The control panel (Figure 1.3) contains a display screen and keypad. Run information can be entered 
and advanced features accessed by using the drop-down menus on the touchscreen, the keypad, or 
a combination of both. You can use a finger, a stylus, or an implement such as a pencil eraser or 
point to access the touchscreen.

Figure 1.3  Control Panel

Settings Screen

The main window is a touchscreen interface display, which comprises touch-sensitive display fields 
and buttons for entering and displaying run parameters and program information. Use your 
fingertip to press the buttons on the touchscreen or to access menus.

For manual operation, the Settings screen is used to enter the speed-time-temperature combination 
required for the run. In addition, you may select acceleration and deceleration profiles, preset the 
starting or ending time of the run, and precool or heat the instrument to the required temperature.
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Description
Control Panel 
Figure 1.4  Settings Screen

When parameters are entered, the run is started by pressing (Enter) , then (Start) . (For safety 
reasons, the instrument does not start a run unless (Start)  is activated within 5 seconds of 
activating (Enter) .) Pressing (Stop)  (on the keypad) at any time terminates a run.

If the run was downloaded from a previously established program, the program name and the rotor 
in use is displayed.

Step Program Run

The program window is accessed by selecting Step Program Run from the Setup menu. It contains 
the same information as the single-step window, except either single or multiple steps (up to five 
steps per program) can be entered before the run is started. The information is entered for each 
step, except Accel and Decel—acceleration profile will be for the first step only, and deceleration 
profile will be for the last step of the run.
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Description
Control Panel 1
Figure 1.5  Step Program Screen

Table 1.1  Step Program Screen Features

Screen Element Description

a Rotor Menu Rotor in use is entered or selected from the pull-down menu

b Rotor List Displays a full list of Beckman Coulter rotors

c Tube List Displays a list of tubes available for the selected rotor 

d Tube Menu Tube in use is entered (optional)

e Rotor Speed Required rotor speed is entered for each step

f Run Time Required run time for each step is entered for a timed run

g Run Temperature Required run temperature is entered for each step

h Acceleration First step only—Maximum acceleration or one of nine slower 
acceleration profiles can be entered to minimize sample-to-
gradient interface disturbance; Max (maximum) is the default

i Deceleration Last step only—Maximum deceleration, one of nine slower 
deceleration profiles, or No Brake can be entered to minimize 
sample-to-gradient interface disturbance; Max (maximum) is the 
default

j (Clear Steps) Pressed to erase information entered in all steps

k (Program Log) Pressed to access the last Program Log

l (Download) Pressed to download the program to the Settings window

m (Save) Pressed to save the program to the instrument memory

n (Close) Pressed to close the program without downloading it to the 
Settings window

d

j

i

nk

m

e g

a

f

h

c

b

l
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Description
Rotor Chamber 
Speed, time, and temperature values are entered for all steps, then acceleration and deceleration 
numbers for the complete run can be entered.

When run parameters for all steps are entered and downloaded to the Settings window, the run can 
be started by pressing (Enter) , then (Start) . (For safety reasons, the instrument will not start a run 
unless (Start)  is activated within 5 seconds of activating (Enter) .) A run can be terminated at any 
time by pressing (Stop)  on the keypad.

Advanced-Use Windows

Advanced functions that use centrifugation-related parameters, such as RCF, ω2t, separation type 
(pelleting or rate zonal), or specific sample or gradient, are used by accessing appropriate windows. 
These windows are described in CHAPTER 3, Operation or CHAPTER 4, Simulations.

Rotor Chamber

The chamber door is made of high-strength structural steel. A solenoid interlock prevents it from 
being opened during operation. The door can be opened only if the power is on and the vacuum is 
off, with the chamber at atmospheric pressure. See CHAPTER 6, Troubleshooting for instructions on 
accessing the chamber to retrieve your sample in case of a power outage.

Vacuum System

The Optima L-XP uses a diffusion pump in series with a mechanical vacuum pump to reduce 
chamber pressure to below 5 microns (0.7 Pa). The system is automatically activated when (Enter)  
and (Start)  are pressed, or may be turned on directly by pressing (Vacuum) , if the chamber door 
is closed. The vacuum system is also automatically activated when precooling or preheating of the 
rotor is selected. (When the rotor is at rest, the instrument maintains a partial vacuum.) When the 
vacuum system is on, the chamber pressure is displayed in microns in the Status window.

At the end of a run, the chamber vacuum must be vented (by pressing (Vacuum)  on the keypad) 
before the door can be opened. (The vacuum cannot be turned off when the rotor is spinning faster 
than 3 000 rpm. If the key is pressed, an error message will appear.) After the door is opened, the 
chamber returns to approximate room temperature to minimize condensation collecting in the 
chamber. To help keep the chamber dry and clean, keep the door closed whenever possible.

In zonal operation, the door may be kept open while the rotor is spinning up to 3 000 rpm. The 
vacuum system is activated when the door is closed (after loading the rotor) and can be vented 
before the rotor is unloaded, while the rotor is still spinning at up to 3 000 rpm.
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Description
Temperature Sensing and Control 1
Temperature Sensing and Control

Rotor temperature is monitored by a radiometer mounted in the bottom of the rotor chamber when 
the chamber pressure is below 100 microns. Above 100 microns, chamber temperature is measured 
by a thermistor mounted in the chamber. (If the radiometer fails, a diagnostic message appears and 
the system reverts to control by the thermistor; the run will continue.)

The Optima L-XP uses a solid state thermoelectric refrigeration and heating system. Neither coolant 
nor water is needed; cooling is provided by forced air from the fans.

When the power is on, the temperature control system activates when the door is closed and the 
vacuum system is turned on. The displayed rotor temperature is controlled to ±0.3°C of the set 
value.

Run temperature can be set at 0 to 40°C.

Drive

The frequency-controlled, air-cooled, direct-drive induction motor requires no gears or brushes. In 
addition, the drive does not require an oil vacuum seal, external oil reservoir, or continuously 
operating damper.* Externally cooled by forced air and internally cooled by oil, the drive delivers 
ultra-smooth, quiet performance, with high rotor-imbalance tolerance.

Safety Features

The Optima L-XP ultracentrifuge has been designed and tested to operate safely indoors at altitudes 
up to 2 000 m (6 562 ft).

Door

The high-strength structural steel chamber door has a solenoid interlock to prevent operator 
contact with a spinning rotor. When the door is closed it locks automatically. It can be opened only 
when the power is on and the rotor is at rest with the chamber at atmospheric pressure. If there is 
a power failure, the door lock can be manually tripped for sample recovery (see CHAPTER 6, 
Troubleshooting).

Barrier Ring

A 41-mm (1.63-in.) steel alloy armor ring acts as the primary barrier, surrounded by a 13-mm 
(0.5-in.) vacuum chamber to provide full protection for the operator.

* U.S. Patent No. 4,846,773.
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Description
Specifications 
Imbalance Detector

An imbalance detector monitors the rotor during the run, causing automatic shutdown if rotor 
loads are severely out of balance. At low speeds, an incorrectly loaded rotor can cause an imbalance.

Overspeed System

The overspeed system is a safety feature designed to ensure that the rotor does not exceed its 
maximum allowable speed. This system includes a photoelectric device in the rotor chamber next 
to the drive spindle and an overspeed disk on the bottom of the rotor. Individual rotor manuals 
provide information on the correct overspeed disks to be used with each rotor.

The overspeed disk has alternating light and dark sectors. As the rotor spins, the passage of 
reflecting and nonreflecting sectors over the photoelectric device generates a series of pulses that 
are detected by the electronic circuitry and software.

After the rotor reaches 1 000 rpm, the set speed is checked against the overspeed disk. If the set 
speed is greater than the maximum speed permitted by the disk, the speed setting is automatically 
lowered to the disk’s maximum speed, but the run continues without interruption. An error 
message is displayed to alert you to the change.

Dynamic Rotor Inertia Check (DRIC)

As the rotor accelerates between 15 000 and 20 000 rpm, rotor inertia is measured and the rotor 
energy is calculated for the speed set by the user. If the calculated rotor energy is determined to be 
excessive, the instrument recalculates a permitted set speed and uses this value to avoid possible 
rotor damage. A diagnostic message is displayed to indicate the change.

Specifications

NOTE Only values with tolerances or limits are guaranteed data. Values without tolerances are informative 
data, without guarantee.

Table 1.2  Specifications

Specification Description

Speed  • Optima L-100XP set speed: 1 000 to 100 000 rpm in 100-rpm increments
 • Optima L-80XP set speed: 1 000 to 80 000 rpm in 100-rpm increments
 • Speed control: Actual rotor speed, ±10 rpm of set speed after 

equilibration (above 1 000 rpm)
 • Speed display: Actual rotor speed in 10-rpm increments below 1 000 rpm 

and 100-rpm increments ≥1 000 rpm

Time  • Set time: To 999 hours 59 minutes; Hold for continuous runs
 • Time display, manual operation: Indicates time remaining in timed runs, 

time elapsed in Hold runs, or estimated time remaining in ω2t runs
 • Time display, programmed operation: Time remaining in step
PN LXP-IM-71-8



Description
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ω2t Integrator  • Calculate time for ω2t: Up to 9.99 × 1014 radians squared per second
 • ω2t display: Shows the accumulated ω2t to two significant digits (in 

exponential notation)

Temperature Set temperature: 0 to 40°C in 1°C increments
Temperature control (after equilibration): ±0.3°C of set temperature
Temperature display: Actual rotor temperature in 0.1°C increments
Ambient temperature range: 10 to 40°C

Humidity Restrictions <95% (noncondensing)

Vacuum Below 5 microns (0.7 Pa)

Acceleration 10 acceleration profiles— 9 slow rates or maximum acceleration from 0 to
set speed

Deceleration 11 deceleration profiles—9 slow rates, coasting to a stop without brake, or
full dynamic braking from set speed

Dimensions  • Width: 94.0 cm (37 in.)
 • Depth: 67.3 cm (26.5 in.)
 • Height: 125.7 cm (49.5 in.)

Weight 465 kg (1025 lb)

Ventilation Clearances  • Sides: 5.1 cm (2.0 in.)
 • Rear: 15.2 cm (6.0 in.)

Finishes  • Keypad: Coated polycarbonate
 • Top surface: Acrylic baking enamel
 • Other surfaces: General-purpose paint

Electrical Requirements  • 200/240-V instrument: 180–264 VAC, 30 A, 50/60 Hz
 • 200/240-V instrument: 198–264 VAC, 30 A, 50 Hz

Electrical Supply Class I

Maximum Heat 
Dissipation into Room 
Under Steady-State 
Conditions

3400 Btu/hr (1.0 kW)

Noise Level 0.91 m (3 ft) 
in front of Ultracentrifuge

<53 dBa

Installation (Overvoltage) 
Category

II

Pollution Degree 2a

a. Normally only nonconductive pollution occurs; occasionally, however, a temporary conductivity caused by condensation 
must be expected.

Table 1.2  Specifications (Continued)

Specification Description
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Available Rotors 
Available Rotors

All currently manufactured Beckman Coulter ultracentrifuge rotors can be used in the Optima™ 
L-XP series ultracentrifuges. The rotors are described in individual manuals that accompany each 
rotor. Information on rotors and accessories is also available in Rotors and Tubes for Preparative 
Ultracentrifuges (LR-IM) and in the Beckman Coulter Ultracentrifuge Rotors, Tubes & Accessories 
catalog (publication BR-8101). The Beckman Coulter web site, http://www.beckmancoulter.com, 
contains additional information about centrifugation processes and products.

Name Rating Plate

A name rating plate is affixed to the rear of the instrument. Always mention the serial number and 
model or system ID number when contacting Beckman Coulter regarding your Optima™ L-XP 
ultracentrifuge.
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CHAPTER 2

Preinstallation Requirements

Introduction

NOTE Do not attempt to install or turn on the power to the Optima L-XP. Its purchase price includes 
installation by Beckman Coulter personnel. Installation by anyone other than authorized Beckman 
Coulter personnel invalidates any warranty covering the instrument.

Preinstallation requirements have been sent prior to shipment of the instrument. (Copies are also 
attached to the outside of the shipping container.) The following information is provided in case the 
Optima L-XP must be relocated. Contact Beckman Coulter Field Service to adjust and level the 
instrument if it must be moved. (The pads on each leveling leg are designed to prevent possible 
rotation of the instrument in the case of a rotor mishap.)

Space Requirements

WARNING

Do not place the ultracentrifuge near areas containing flammable reagents or 
combustible fluids. Vapors from these materials could enter the ultracentrifuge 
air system and be ignited by the motor. Maintain a 30-cm (1-ft) clearance envelope 
around the ultracentrifuge while it is running. No persons or any hazardous 
materials should be within this clearance boundary while the ultracentrifuge is 
operating except to change operating controls, if required.

Locate the ultracentrifuge in a clean, safe, uncluttered environment. Provide a 5.1-cm (2-in.) 
clearance on each side of the instrument, as the feet extend about 5.1 cm (2 in.) beyond the 
instrument. (The pads under each foot are designed to prevent possible rotation of the instrument 
in the event of a rotor mishap.) A 15.2-cm (6-in.) clearance is required at the rear of the instrument 
for servicing and to ensure sufficient air ventilation. The ultracentrifuge must have adequate air 
ventilation to ensure compliance to local requirements for vapors produced during operation.

The instrument will operate within specifications in a laboratory with ambient temperatures 
ranging from 10 to 40°C.
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Preinstallation Requirements
Bio-Safety Level 3 Installation 
Figure 2.1  Dimensions of the Optima L-XP Ultracentrifuge

Bio-Safety Level 3 Installation

For laboratories with epoxy aggregate floors, such as BSL-3 labs, a non-invasive installation kit 
(PN 393862) is available. The kit, which consists of a high-strength adhesive tape, is CSA certified for 
use on expoy aggregate floors only.

Electrical Requirements

To reduce the risk of electrical shock, this equipment uses a three-wire electrical cord (1.8 m; 6 ft) 
and plug (see Figure 2.2) to connect the equipment to earth ground. In regions where the 
instrument is supplied with an unterminated cord, a plug that meets local electrical and safety 
requirements must be supplied. (Contact your local Beckman Coulter office for specific information 
regarding these requirements.) See Table 2.1 for the required wire connections. Make sure that the 
matching wall outlet receptacle is properly wired and earth-grounded.

cm
in.

94.0
37

5.1
2

5.1
2

67.3
26.5

15.2
6

Instrument Rating: 220 to 240 VAC, 50 Hz, 20 A
200 to 240 VAC, 50/60 Hz, 20 A

Power Line Range: 180 to 264 VAC, 60 or 50 Hz (single-phase), 30 A
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Preinstallation Requirements
Attaching a Printer 2
Figure 2.2  Electrical Connection

To ensure safety, the instrument should be wired to a remote emergency switch (preferably outside 
the room where the ultracentrifuge is housed, or adjacent to the exit from that room), in order to 
disconnect the instrument from the main power source in case of a malfunction.

Attaching a Printer

A printer can be used with the Optima™ L-XP to print out run setups, programs, simulations, 
instrument logs, or run records. A Hewlett Packard Deskjet 940c printer (963423), available from 
Beckman Coulter, can be plugged into the parallel port on the back of the instrument control head 
(see Figure 2.3).

NOTE The print driver for the Beckman Coulter supplied Deskjet 940c printer resides in the Optima™ L-XP 
eXPert software. If a different printer is used, the print driver will have to be installed by Beckman Coulter 
Field Service.

Table 2.1  Required Wire Connections

Wire Insulation Color Terminal Symbol

Harmonized North American

Green/Yellow Earth ground

Light Blue Neutral N L

Brown Live or Line L L

Measured 
Line Voltage

Wall Outlet:
Hubbell 9330,
Bryant 96-30-FR,
or Equivalent
(NEMA 6-30 R)

30-ampere
Circuit

Protector

Earth
Ground North

American
Plug

30-ampere
Circuit

Protector
PN LXP-IM-7 2-3



Preinstallation Requirements
Attaching a Printer 
Figure 2.3  Printer Connection

Parallel
Port
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CHAPTER 3

Operation

Introduction

This chapter contains manual and programmed operating procedures. Refer to the applicable rotor 
manual for information about the use and care of rotors and accessories.

Power

If the power is off, flip the circuit breaker at the right side of the instrument to on (up position). 
Power should be left on except in the case of an emergency or when maintenance is required.

To end a run for any reason, press (Stop)  on the keypad.

Key Switch Positions

Insert the key into the interlock switch on the control head to select normal, locked, or zonal 
operation. The arrow on the key should point in the direction of the selected position. Icons for 
normal, locked, and zonal are displayed next to the interlock on the control head.

Figure 3.1  Key Switch Positions

Normal Zonal

Locked
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Operation
Key Switch Positions 
Normal Position

Turn the key to the normal position for routine closed-door centrifugation. The key should be 
removed while in this position.

Figure 3.2  Normal Key Switch Position

Locked Position

To ensure that run parameters are not changed during centrifugation, turn the key to the vertical 
position to run the instrument in locked operation. The key should be removed while in this 
position. LOCKED mode will appear at the bottom of the Status window.

Figure 3.3  Locked Key Switch Position

Zonal Position

Turn the key to the zonal position for runs in which a zonal rotor is being used. The key cannot be 
removed while the instrument is running in a zonal operation. ZONAL mode will appear at the 
bottom of the Status window.

As a safety feature, to repeat a zonal run you must reset the key by turning it clockwise out of the 
zonal position and then back again into the zonal position. Then press (Enter)  and (Start)  again to 
begin the next zonal run.

Figure 3.4  Zonal Key Switch Position
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Touchscreen Interface 3
Touchscreen Interface

The operation of the Optima™ L-XP is controlled through the touchscreen interface display, which 
comprises touch-sensitive display fields and buttons for entering and displaying run parameters 
and program information. Use your fingertip to press the buttons on the touchscreen or to access 
menus.

During operation, the Speed, Time, and Temp display windows on the Settings screen display real-
time status.

Basic Operation

Load and install the rotor as described in the applicable rotor manual, then close the door.

Run information is entered directly and advanced features accessed by using the drop-down menus 
on the Settings screen, the keypad, or a combination of both.

Figure 3.5  Touchscreen and Keypad Operation

Touchscreen—Enter run information using the touchscreen by touching the arrow to the right of a 
parameter field, then scrolling to the required value on the drop-down menu. (Save) , (Enter) , and 

(Start)  (not accessible through the keypad) are initiated by simply touching the key. The System 
menu, which can only be accessed using the touchscreen, includes:

 • File—Contains the print menus and lists previously opened files

 • Setup—Step Program Run, RCF Run, ω2t Run, Substitute Rotor Run, Auto Pelleting Run, Auto 
Rate Zonal Run, and Recall Program menu

 • Simulate—ESP Pelleting Run, ESP Rate Zonal Run, ESP Plasmid Run, ESP RNA Run (Best), ESP 
RNA Run (Fast) simulations, as well as Recall Simulation

 • Calculate—Pelleting Time, Concentration Measures, Refractive Index/Density, Reduced Speed 
for Dense Solutions, Reduced Speed for Precipitating Solutions, Sedimentation Coefficient from 
Run Data, Sedimentation Coefficient from Molecular Mass
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Operation
Logging In 
 • Reference—Rotor Catalog, Tube Catalog, and Chemical Resistance Chart

 • Logs—Instrument Usage Log, Display Last Run Record, and Print Last Run Record Automatically 
selection

 • Window—Restore Windows and Display Total ω2t Box functions

 • Optima L-XP—Field Service and System Management access, Change PIN and Export Data 
functions, and About Optima L-XP which contains software version number, copyright 
information, and local field service name and contact information

Keypad—Information (except system menus and the (Save) , (Enter) , and (Start)  functions) is 
entered using the keypad by using the tab and arrow keys to navigate through the Setup windows 
and entering values using the numeric keypad. (The backspace key on the keypad moves the cursor 
to the left, erasing characters.) The (Vacuum)  key, used to start the vacuum system before the run 

begins, and the (Stop)  key, used to stop a run for any reason, are accessible only through the 
keypad, and are available regardless of the window displayed.

Use one of the setup procedures described in the following pages to set up and start the run. When 
the run begins, the following actions occur:

 • The vacuum system is activated (unless the vacuum was previously started) to reduce chamber 
pressure to below 5 microns (0.7 Pa). The chamber pressure is displayed in microns in the Status 
window.

 • When the rotor speed reaches 1 000 rpm, the set speed is checked against the overspeed disk. If 
set speed is greater than the maximum speed allowed by the disk, the speed setting is lowered 
to the disk maximum speed. An error message alerts you to the change.

 • The rotor will not accelerate beyond 3 000 rpm until the chamber pressure drops below 
750 microns. At that time the rotor accelerates to the set speed.

 • The run status is continuously displayed in the Status window.

Logging In

Depending on the type of action to be performed, you may need to log in prior to the start of a run. 
If User Login is enabled by your Administrator, you will be required to enter your user name 
accompanied by a Personal Identification Number (PIN). Check with your Administrator to obtain a 
user profile.

Figure 3.6  Login Button

To log in:

1. To log in prior to performing any other actions, press the (Login)  button on the Settings screen. 

The User Login screen appears. Go to Step 2 if you pressed the (Start)  button to start a run and 
the User Login screen automatically displayed.
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System-Level Operations 3
Figure 3.7  User Login Screen

2. Select your user name, enter your PIN on the keypad, and press (OK)  to accept. The Settings 
screen returns to view. If you were required to log in, the run starts or, if enabled by the 
administrator, the Run Comment screen appears.

NOTE If the instrument is powered down while the user is logged in, the user will automatically be 
logged in when power is restored to the instrument. To prevent automatic login upon machine 
startup, please log off and allow at least 5 seconds for processing before turning off the instrument.

System-Level Operations

The Administrator performs system-level operations, such as adding and deleting users, requiring 
User Login, requiring Rotor Selection, and enabling a Run Comment before starting a run. These 
operations are accessed through the System Management screen. Any user with Administrator 
privileges has access to these functions.

To log in as the Administrator:

1. Log in as the Administrator (if you are not logged in already).

2. On the Settings screen, select System Management from the Optima L-XP drop-down menu. The 
System Management screen appears.
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System-Level Operations 
Figure 3.8  System Management Screen

Adding a User

To add a user:

1. From the System Management screen, press the (Add User)  button. The Add User Name screen 
appears.

Figure 3.9  Add User Screen

2. Enter a user name on the keypad. Uppercase letters are default. To enter lowercase letters, press 
the (Shift)  key. Press (Back)  to erase entered characters one at a time. To clear the entire entry, 

press (Clear) .

3. When the user name is entered, press the (OK)  button. The New PIN screen appears.
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Figure 3.10  New PIN Screen

4. Enter a PIN number 4 to 6 digits in length on the keypad, and press the (OK)  button to accept. 
The Confirm PIN screen appears.

NOTE The PIN number is masked on the screen during entry.

Figure 3.11  Confirm PIN Screen

5. Enter the PIN number again, and press the (OK)  button to accept. The Set Role screen appears. 
On this screen, Administrators must assign one of three security roles that control access to 
specific instrument functions:

 • Administrator—This level can access all instrument functions including adding users and 
instrument settings.

 • Super User—This level can create and run programs, use simulations and calculations, 
modify the rotor library, and access instrument logs.

 • Operator—This level can access selected runs and programs.
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System-Level Operations 
Figure 3.12  Set Role Screen

NOTE Although not listed on the Set Role screen, there is an additional security role for Field Service. 
This role has the same access as an Administrator but with additional field service access.

6. Assign the user a security level by selecting the appropriate role.

7. If programs have been added to the Program Library, you can assign the new user access to 
these programs by selecting each in the Selecting Programs menu of the Set Role screen. Select 
a single program by pressing on the program name or, press the (Select All)  or (Clear All)  
button as appropriate.

8. Press the (OK)  button to confirm. To add another user, repeat Steps 2 to 8.

Copying Users

The profiles of existing users may be copied to create a new user profile that retains the same 
security role as the original.

To copy a user:

1. From the System Management screen, select a user name from the user list and press the 
(Copy User)  button. The Copy User Name screen appears.

2. Enter a user name on the keypad. Uppercase letters are default. To enter lowercase letters, press 
the (Shift)  key. Press (Back)  to erase entered characters one at a time. To clear the entire entry, 

press (Clear) .

3. When the user name is entered, press the (OK)  button. The New PIN screen appears.

4. Enter a PIN number 4 to 6 digits in length on the keypad, and press the (OK)  button to accept. 
The Confirm PIN screen appears.

NOTE The PIN number is masked on the screen during entry.

5. Enter the PIN number again, and press the (OK)  button to accept. The System Management 
screen returns to view, and the user name is added from the list.
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Set PIN Number

The PIN numbers of existing users may be changed in scenarios where the original PIN has been 
forgotten or the security of the original PIN number has been compromised.

To set a PIN number:

1. From the System Management screen, select a user name from the user list and press the 
(Set PIN)  button. The New PIN screen appears.

2. Enter a new PIN number 4 to 6 digits in length on the keypad, and press the (OK)  button to 
accept. The Confirm PIN screen appears.

NOTE The PIN number is masked on the screen during entry.

3. Enter the PIN number again, and press the (OK)  button to accept. The System Management 
screen returns to view.

Set Role

The security level assigned to existing users may be changed if access to specific instrument 
functions and programs needs to be expanded or restricted.

To assign a role to a user:

1. From the System Management screen, select a user name from the user list and press the 
(Set Role)  button. The Set Role screen appears. On this screen, reassign one of three security 
roles that control access to specific instrument functions.

 • Administrator—This level can access all instrument functions including adding users and 
instrument settings.

 • Super User—This level can create and run programs, use simulations and calculations, 
modify the rotor library, and access instrument logs.

 • Operator—This level can access selected runs and programs.

2. Reassign the user a security level by selecting the appropriate option.

3. If programs have been added to the Program Library, you can assign the user access to these 
programs by selecting each in the Selecting Programs menu of the Set Role screen. Select a 
single program by pressing on the program name or, press the (Select All )  or (Clear All)  button 
as appropriate.

4. Press the (OK)  button to confirm. The System Management screen returns to view.

Removing Users

To remove a user:

1. From the System Management screen, select a user name from the user list and press the 
(Remove User)  button. A message appears to confirm the action.
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2. Press the (Yes)  button to confirm. The System Management screen returns to view, and the 
user name is deleted from the list.

NOTE The default Administrator role cannot be removed from the user list.

Require User Login

A user may be required to log in prior to starting a run. With each login, the user actions are 
recorded in the run log.

To set up required user login:

1. From the System Management screen, check the box next to Require User Login to enable this 
function.

Figure 3.13  Enable User Login Option

2. Press the (Close)  button to exit the System Management screen.

Required Rotor Selection

When Require Rotor Selection is enabled, the user must select a rotor before starting a run. If a rotor 
is not selected, the user will be prompted to select the rotor in use.

To select a rotor:

1. From the System Management screen, check the box next to Require Rotor Selection to enable 
this function.

2. Press the (Close)  button to exit the System Management screen.
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Enable Run Comment

When a Run Comment is enabled, the user can enter a run comment (up to 255 characters) before 
starting a run. A run comment is typically used to record the batch and lot information.

To enable run comment:

1. From the System Management screen, check the box next to Enable Run Comment to enable 
this function.

2. Press the (Close)  button to exit the System Management screen.

Manual Operation

You can set up a run manually, or by using a previously saved run program or a simulation program. 
The following procedure describes setting up a run using manual setup.

Figure 3.14  Settings Screen

To set up a run manually:

1. Enter required speed (between 1 000 rpm and the rotor maximum speed) by keying in the 
numbers or selecting a speed from the Set Speed (RPM) drop-down menu.

2. Enter required time (up to 999 hours and 59 minutes) by keying in the hours and minutes or 
selecting a time (or Hold) from the Time (hr:min) drop-down menu.
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3. Enter temperature (between 0 and 40°C) by keying in the numbers or selecting a value from the 
Set Temp (°C) drop-down menu.

NOTE If Run Comment has been enabled by the Administrator, the user is prompted to enter a comment 
(up to 255 characters) before starting the run. This feature is typically used to record the batch and 
lot information.

To start the run at this point, using default settings for the remaining parameters, press 
(Enter) , then (Start) . The default maximum acceleration and deceleration times will be used; 
to select acceleration and deceleration profiles, go on to Steps 4 and 5.

NOTE If you press (Start)  without first pressing (Enter) , the run will not start. You must press (Enter)  

then (Start)  (within 5 seconds) to begin a run.

4. To minimize sample-to-gradient interface disturbance, enter one of nine slower acceleration 
profiles (see Table 3.1) by keying in the profile number or making a selection from the Accel 
drop-down menu.

5. To minimize sample-to-gradient interface disturbance, enter one of nine slower deceleration 
profiles (see Table 3.1), or No Brake, by keying in the profile number or making a selection from 
the Decel drop-down menu.

NOTE You can start the run at this point, or enter additional (optional) parameters, such as precooling 
or heating the chamber or setting the run for a delayed start (delay time must be less than one 
week).

Table 3.1  Acceleration and Deceleration Profiles

Acceleration Deceleration

Profile 
Number

Transitiona

a. The speed at which the rotor ends its slow acceleration and begins maximum acceleration to set 
speed. 

Profile 
Number

Transitionb

b. The speed at which the rotor begins its slow deceleration; until that point the rotor has been 
decelerating with full dynamic braking. 

Speed 
(RPM) Time

Speed 
(RPM) Time

Max Maximum Acceleration Max Maximum Deceleration

1

2

3

4

5

6

7

8

9

170

350

500

170

350

500

170

350

500

2:00

2:40

3:00

3:00

4:00

4:30

4:00

5:20

6:00

1

2

3

4

5

6

7

8

9

170

350

500

170

350

500

170

350

500

2:00

2:40

3:00

3:00

4:00

4:30

4:00

5:20

6:00

No Brake Rotor coasts from full 
speed to stop
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6. Press (Delay Start) , then enter the time that you want the run to begin or end. Press (OK) . The 
run begins when the Delay Start countdown has ended.

Figure 3.15  Delay Start Screen

NOTE When the Delay Start function is used in conjunction with the Require User Login function, users 
are automatically logged out after two minutes of inactivity.

7. To cancel Delay Start, press the (Stop)  button on the control panel.

8. Press (Precool/Heat) , then enter chamber precool or preheat temperature. Press (Start Temp)  
to begin temperature control.

Figure 3.16  Precool/Heat Temperature Screen

NOTE To save the run parameters for future recall, press (Save) , then enter a program name in the 
dialog box.

9. When all required parameters are entered, press (Enter) , then (Start) . You can terminate a run 

at any time by pressing (Stop)  on the keypad.

NOTE Run parameters may be printed out for record keeping purposes. See CHAPTER 2, Preinstallation 
Requirements, for printer hookup instructions.

If you downloaded the run from a previously established program, the program name and the rotor 
in use (if a rotor was selected) will be displayed below the parameter entry positions.
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Programmed Operation

Figure 3.17  Setup Menu

Program options are accessed through the Setup menu. You can enter, save, and recall programs 
containing protocols that you plan to re-use. Each saved program is stored in a separate file for easy 
run duplication. Several of the program setup windows can also be used to determine parameters 
through calculations or conversions. Most program setup windows have an upper portion where 
calculations and conversions are done, and a lower portion where you can enter additional run 
parameters if you want to download or save the program.

If you downloaded a program before you saved it, and you are still in the Settings window, you can go 
back to that program window by pressing (View Program) . If you downloaded a program before you 
saved it, and you are no longer in the Settings window, you may be able to retrieve the program from 
the File menu in the top menu bar.

Figure 3.18  File Types

Step and ESP programs may be printed out for record keeping purposes. See CHAPTER 2, 
Preinstallation Requirements, for printer hookup instructions.
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Step Program

To use step program:

1. Select Step Program Run from the Setup menu.

Figure 3.19  Step Program Screen

2. Enter rotor name and tube type (optional) or press (R... )  (rotor) and select from the drop-down 
menu.

NOTE Continuous flow and zonal rotors are only used in single step runs; conversion functions do not 
apply to these rotors.

3. Enter speed, time, and temperature settings for all steps required (up to five steps per run).

NOTE Use the (Clear Steps)  button to clear all entered steps to re-enter information.

After speed, time, and temperature values are entered for all steps, you can enter acceleration 
(first step only) and deceleration (last step only) profile numbers (see Table 3.1) for the complete 
run.

4. Enter one of nine slower acceleration profiles by keying in the profile number or making a 
selection from the Accel drop-down menu.

5. Enter one of nine slower deceleration profiles, or No Brake, by keying in the profile number or 
making a selection from the Decel drop-down menu.

6. To save the program for later recall, press (Save) . The Save As dialog box opens, and you can 
use the on-screen keyboard to specify a filename.
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Figure 3.20  Save As Dialog

NOTE If you do not save the program under a new filename, it will be overwritten when a new step 
program is run.

7. Press (Download)  to transfer the run parameters to the Settings window; if not saved to a 
specific filename, the program is automatically saved to a temporary file called 
LastStepProgram.spr. (Or press (Close)  to close the program window without downloading it.)

8. Press (Precool Heat)  to enter chamber precool or preheat temperature. Select temperature, 

then press (Start Temp) . The vacuum will start automatically.

or

Press (Vacuum)  on the keypad to start or stop the vacuum pump.

When all required parameters are entered, press (Enter) , then (Start) . A run may be terminated at 

any time by pressing (Stop)  on the keypad.

RPM to RCF Toggle

To toggle between RPM and RCF:

1. On the Settings screen, press the (Display RCF)  button to toggle between RPM and RCF (relative 
centrifugal field) modes. RPM indicates rotor speed in revolutions per minute while RCF 
represents the ratio of the centrifugal acceleration at a specified radius and speed to the 
standard acceleration of gravity.

2. Press the (Display RPM)  button to return to RPM mode.

NOTE A rotor must be selected before toggling from RPM to RCF. The ultracentrifuge requires the rmax 

of the rotor on which to perform calculations.
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RCF Conversion

This window allows you to enter RCF (relative centrifugal force) instead of RPM (revolutions per 
minute). The software then calculates the RPM necessary to achieve the required RCF. 

NOTE This window can also be used to calculate RCF from a given RPM.

Figure 3.21  RCF Run Screen

To use RCF:

1. Select RCF Run from the Setup menu.

2. Enter rotor and tube in use or press (R... )  (rotor) and select a rotor and tube combination from 
the rotor library.

NOTE Continuous flow and zonal rotors are only used in single step runs; no conversion functions apply 
to these rotors.

3. Select RCFmax > Speed (to use the tube’s maximum radius) or RCFav > Speed (to use the tube’s 
average radius).

4. Enter the required RCF.

The equivalent RPM will be calculated and displayed. You can enter the additional run 
parameters then download the settings to the Settings window and start the run, or save as a 
program before downloading.

NOTE To save the program for future recall, press (Save) , then enter a program name in the dialog 
box. If the program is a modification of a previously saved program that you want to retain, you can 
save the new version under a different name by selecting Save As from the File menu.

5. Press (Download)  to transfer the run parameters to the Settings window. If not saved to a 
specific filename, the program is automatically saved to a temporary file called LastRCF.rcf.

6. Press (Enter) , then (Start)  to run the program.
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ω2t

This window allows you to set the run time so that the run will stop when a required ω2t (total 
accumulated centrifugal effect) is achieved.

NOTE The Total ω2t window appears by default on the Settings screen. Select Display Total ω2t from the 
Window drop-down menu to remove or restore this window on the Settings screen.

Figure 3.22  ω2t Run Screen

To set the run to stop at ω2t:

1. Select w2t Run from the Setup menu.

2. Enter rotor and tube in use or press (R... )  (rotor) and select a rotor and tube combination from 
the rotor library.

3. Enter speed (in RPM) and one of the remaining two values:  ω2t (in radians squared per second) 
or time (in hours and minutes).

The third value will be displayed.

 • Time, if you entered values for speed and ω2t

 • ω2t, if you entered values for speed and time

You can enter the additional run parameters then download the settings to the Settings window 
and start the run, or save as a program before downloading.

NOTE To save the program for future recall, press (Save) , then enter a program name in the dialog 
box. If the program is a modification of a previously saved program that you want to retain, you can 
save the new version under a different name by selecting Save As from the File menu.

4. Press (Download)  to transfer the run parameters to the Settings window (or press (Close)  to 
close the window without downloading it).
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5. Press (Enter) , then (Start)  to run the program. If not saved to a specific filename, the program 
is automatically saved to a temporary file called Lastw2t.w2t.

Rotor Conversion

Calculates time required to duplicate run conditions using a different rotor and tube combination.

Figure 3.23  Substitute Rotor Screen

To enter a substitute rotor speed:

1. Select Substitute Rotor Run from the Setup menu.

2. In the First Rotor Information area, enter the rotor and tube used in the original protocol. The 
minimum tube radius and maximum tube radius (in millimeters) from the axis of rotation will 
be displayed if the tube selected is in the Tube Catalog.

3. Enter the speed and time of the run to be duplicated (also in the First Rotor Information area).

4. In the Substitute Rotor Information area, enter the new rotor and tube combination. 

5. Enter the substitute rotor speed.

6. Press (Calculate) .

The run time will be calculated and displayed. You can enter the additional run parameters then 
download the settings to the Settings window and start the run, or save as a program before 
downloading.

NOTE To save the program for future recall, press (Save) , then enter a program name in the dialog 
box. If the program is a modification of a previously saved program that you want to retain, you can 
save the new version under a different name by selecting Save As from the File menu.

7. Press (Download)  to transfer the run parameters to the Settings window. If not saved to a 
specific filename, the program is automatically saved to a temporary file called 
LastSubstituteRotor.srr.
PN LXP-IM-7 3-19



Operation
Programmed Operation 
8. Press (Enter) , then (Start)  to run the program.

Auto Pelleting

Set up run parameters for pelleting a specific particle as follows.

Figure 3.24  Auto Pelleting Run Screen

To set auto pelleting:

1. Select Auto Pelleting Run from the Setup menu.

2. Specify the sedimentation coefficient of the particle of interest by selecting the bar, then using 
the keypad arrow keys to slide the indicator along the bar until the correct s value appears in 
the field to the right of the slide bar.

NOTE Sedimentation coefficient value reported is usually s20, w, which means 20°C in water. If the run 
temperature is set to other than 20°C, the s value must be adjusted for the temperature difference.

3. Enter the rotor and tube combination and the speed.

The run time required to pellet the particle (in water) will be calculated and displayed. You can 
enter the additional run parameters then download the settings to the Settings window and 
start the run, or save as a program before downloading.

NOTE To save the program for future recall, press (Save) , then enter a program name in the dialog 
box. If the program is a modification of a previously saved program that you want to retain, you can 
save the new version under a different name by selecting Save As from the File menu.

4. Press (Download)  to transfer the run parameters to the Settings window. If not saved to a 
specific filename, the program is automatically saved to a temporary file called 
LastAutoPelleting.apr.
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5. Press (Enter) , then (Start)  to run the program.

Auto Rate Zonal

Set up run parameters for rate zone separations as follows. 

Figure 3.25  Auto Rate Zonal Screen

To set auto rate zonal separations:

1. Select Auto Rate Zonal Run from the Setup menu.

2. Select the rotor and tube combination.

3. Select the Sedimentation Coefficient bar, then use the keypad arrow keys to slide the indicator 
along the bar to display the lower sedimentation coefficient particle of interest. The software 
calculates a run time corresponding to a separation at 75% of the tube volume. It also calculates 
a hypothetical contaminant of minimum s value that separates this material at 25% of the tube 
volume.

4. Select the gradient type.

5. Select particle density (in g/mL).

The run time required will be calculated and displayed. You can enter the additional run 
parameters then download the settings to the Settings window and start the run, or save as a 
program before downloading.

NOTE To save the program for future recall, press (Save) , then enter a program name in the dialog 
box. If the program is a modification of a previously saved program that you want to retain, you can 
save the new version under a different name by selecting Save As from the File menu.
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6. Press (Download)  to transfer the run parameters to the Settings window. If not saved to a 
specific filename, the program is automatically saved to a temporary file called 
AutoRateZonal.arr.

7. Press (Enter) , then (Start)  to run the program.

Recall Program

You can recall previously saved programs containing protocols that you want to re-use or modify.

Figure 3.26  Open File Dialog

To recall a previously-saved program:

1. Select Recall Program from the Setup menu.

2. Select the program you want to recall.

3. Press (Open)  to open the program.

4. Press (Download)  to transfer the run parameters to the Settings window.

NOTE You can modify the program before running it, but changes will not be saved unless you save the 
altered program under a new name.

5. Press (Enter) , then (Start)  to run the program.

Remote Operation

The Optima™ L-XP ultracentrifuge may be operated from a remote computer. See APPENDIX A, 
Remote Access, for more information on this feature.
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Using Calculation Features

The calculations feature performs a variety of calculations commonly used in ultracentrifugation. 
These calculations help simplify run preparation and are accessed from the Calculate menu during 
the setup process, but cannot be downloaded to a setup screen.

Figure 3.27  Calculate Menu

Pelleting Time Calculation

Figure 3.28  Calculate Pelleting Time Screen

To calculate the pelleting time:

1. Select Pelleting Time from the Calculate menu.

2. Select the rotor and tube in use.

3. Enter the sedimentation coefficient of the particles being separated.

4. Enter the speed in RPM or RCF.

5. Press (Calculate) .

The time required to pellet the particles appears in the Pelleting Time (hr:min) field, and the 
RCF will be displayed if you selected RPM, or RPM will be displayed if you selected RCF.

6. Note the calculated time, then press (Close)  to close the window.
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Concentration Measures

Figure 3.29  Calculate Concentration Measures Screen

To convert units of measurement:

1. Select Concentration Measures from the Calculate menu.

2. Select a gradient solution (sucrose or CsCl).

3. Enter the value for one of: density, molarity, %w/v (weight-to-volume), or %w/w (weight-to-
weight).

4. Press (Calculate) .

The remaining three parameters are calculated and displayed. 

5. Note the calculated parameters, then press (Close)  to close the window.

Refractive Index/Density

Figure 3.30  Calculate Refractive Index/Density Screen
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To calculate values of refractive index, density, or concentration:

1. Select Refractive Index/Density from the Calculate menu.

2. Enter the value for one of: refractive index, density, or molarity.

3. Press (Calculate) .

The remaining two parameters are calculated and displayed. 

4. Note the calculated parameters, then press (Close)  to close the window.

Speed Reduction for Dense Solutions

Reduce run speed when centrifuging a solution with a density greater than the allowable density 
rating of the rotor (as listed in the applicable rotor manual) to protect the rotor from excessive 
stresses due to the added load.

Figure 3.31  Calculate Reduced Rotor Speed for Dense Solutions Screen

To calculate reduced speed for dense solutions:

1. Select Reduced Speed for Dense Solutions from the Calculate menu.

2. Select a rotor and tube combination. The maximum speed for that rotor and tube combination 
will be displayed.

3. Enter the average density of the tube contents in g/mL.

4. Press (Calculate) .

The maximum allowable speed is displayed.

5. Note the calculated speed, then press (Close)  to close the window.
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Speed Reduction for Precipitating Solutions

Reduce run speed to avoid precipitation of CsCl during centrifugation of concentrated CsCl 
solutions.

Figure 3.32  Calculate Reduced Rotor Speed for Precipitating Solutions Screen

To calculate reduced speed for precipitating solutions:

1. Select Reduced Speed for Precipitating Solutions from the Calculate menu.

2. Select a rotor and tube combination.

3. Enter the average density of the tube contents in g/mL.

4. Press (Calculate) .

The maximum allowable speed is displayed. 

5. Note the calculated speed, then press (Close)  to close the window.

Sedimentation Coefficient from Run Data

Calculate the sedimentation coefficient from the given run data.
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Figure 3.33  Calculate Sedimentation Coefficient from Run Data Screen

To calculate sedimentation coefficient:

1. Select Sedimentation Coefficient from Run Data from the Calculate menu.

2. Select a rotor and tube combination, location from meniscus, gradient, particle density speed, 
time, and run temperature from the drop-down menus.

3. Press (Calculate) .

The sedimentation coefficient (s) is displayed. 

4. Note the calculated s, then press (Close)  to close the window.

Sedimentation Coefficient From Molecular Mass

Estimate the sedimentation coefficient given the molecular weights of the macromolecules.

Figure 3.34  Estimate Sedimentation Coefficient from Molecular Mass Screen
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To calculate sedimentation coefficient:

1. Select Sedimentation Coefficient from Molecular Mass from the Calculate menu.

2. Select the macromolecule.

3. Enter the molecular mass or molecular length of the molecule.

4. Press (Calculate) .

The sedimentation coefficient is displayed. 

5. Note the calculated s, then press (Close)  to close the window.

Restore Windows

If multiple windows are open (such as calculations, simulations, logs, rotor or tube lists), you can 
close all windows and return to the Settings window at any time by selecting Restore Windows from 
the Window menu.
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CHAPTER 4

Simulations

Using Simulation Features

Figure 4.1  Simulate Menu

When running a separation using CsCl, it is critical to keep the salt from precipitating out and 
potentially causing a rotor mishap. This is accomplished by running the rotor below the speed at 
which the salt precipitates. ESP™ (Efficient Sedimentation Program) was developed as a way of 
predicting optimum run conditions for pelleting RNA over a wide variety of rotor and tube 
combinations. ESP accomplishes this by calculating the movement of three components in solution:

 • RNA, ranging in size from 0.1 to 3kb,

 • A hypothetical contaminant of chromosomal DNA, and

 • CsCl

Movement of each component is monitored as a function of speed and considers the geometry of 
different rotor and tube combinations. The program starts out at the maximum rated speed of the 
rotor (less if the overall solution density exceeds the limit of the rotor/tube combination selected), 
and simulates a sequence of steps reducing the speed of the rotor just prior to precipitation of 
the CsCl.

You access the simulations windows from the Simulate menu. You can transfer the optimized run 
program generated from these simulated run parameters to the Settings window and start the run, 
or save the simulation for later use. You can also print out the simulation (see CHAPTER 2, 
Preinstallation Requirements, for printer hookup instructions).
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ESP™ Pelleting

Pelleting separates particles of different sedimentation coefficients, the largest particles in the 
sample traveling to the bottom of the tube first. ESP simulates the formation of gradient and 
separation of sample components to determine the shortest possible run duration that precludes 
precipitation. The simulation predicts the time at which the required separation will be achieved. If 
a step gradient instead of a linear gradient is used, the sample will migrate faster toward the tube 
bottom.

Figure 4.2  ESP Pelleting Screen

To set up ESP pelleting:

1. Select ESP Pelleting Run from the Simulate menu.

2. Enter the sedimentation coefficient of the particle of interest.

NOTE. Sedimentation coefficient value reported is usually s20, w, which means 20°C in water. If the run 
temperature is set to other than 20°C, the s value must be adjusted for the temperature difference.

3. Select the rotor and tube in use.

4. Press (Simulate Protocol) .

The simulation is graphically displayed, showing the movement of the solute as it pellets. Time 
required for the separation is shown in the Elapsed Time (hr:min) field. (Use the slide bar to 
display pelleting at shorter run times.) You can transfer these settings to the Settings window 
and start the run, or save the simulation for later recall. 

NOTE. To save the program for future recall, press (Save) , then enter a program name in the dialog 
box. If the program is a modification of a previously saved program that you want to retain, you can 
save the new version under a different name by selecting Save As from the File menu.
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5. Press (Download)  to transfer the run parameters to the Settings window. If not saved to a 
specific filename, the program is automatically saved to a temporary file called 
LastESPPelleting.spr.

6. Press (Enter) , then (Start)  to run the program.

ESP Rate Zonal

Particle separation achieved with rate zonal separation is a function of the particles’ sedimentation 
coefficient and density, and the viscosity of the gradient material. Under centrifugal force, particles 
migrate as zones. Rate zonal separation is time dependent. ESP simulates the formation of gradient 
and separation of sample components as a function of time and radial position.

Figure 4.3  ESP Rate Zonal Screen

To set up an ESP rate zonal run:

1. Select ESP Rate Zonal Run from the Simulate menu.

2. Enter the sedimentation coefficients of up to three particles of interest.

NOTE Sedimentation coefficient value reported is usually s20, w, which means 20°C in water. If the run 
temperature is set to other than 20°C, the s value must be adjusted for the temperature difference.

3. Select the rotor (swinging bucket only) and tube in use.

4. Select the gradient type.

5. Select the particle density.

6. Enter the run temperature.

7. Press (Simulate Protocol) .
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The simulation positions the particle with the largest s value (fastest pelleting) at the bottom 
of the scale, and shows the relative positions of other selected particles along the tube length. 
The dotted line represents the gradient percentage. Time required for the separation is shown 
in the Elapsed Time (hr:min) window. (Use the slide bar to display conditions at shorter run 
times.) You can transfer these parameters to the Settings window and start the run, or save the 
simulation for later recall. 

NOTE To save the program for future recall, press (Save) , then enter a program name in the dialog 
box. If the program is a modification of a previously saved program that you want to retain, you can 
save the new version under a different name by selecting Save As from the File menu.

8. Press (Download)  to transfer the run parameters to the Settings window. If not saved to a 
specific filename, the program is automatically saved to a temporary file called 
LastESPRateZonal.err.

9. Press (Enter) , then (Start)  to run the program.

ESP Plasmid Run

Simulates an optimized plasmid DNA separation in homogeneous 1.55 g/mL CsCl-EtBr at 25°C. The 
simulation predicts the time at which the required separation will be achieved.

Figure 4.4  ESP Plasmid Run Screen

To set up an ESP plasmid run:

1. Select ESP Plasmid Run from the Simulate menu.

2. Select the plasmid size.

3. Select the rotor and tube in use from the drop-down menu.
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4. Press (Simulate Protocol) .

The simulation is displayed on the graph.

 • The green and blue curves represent the relative concentration of linear and supercoiled 
DNA, respectively.

 • The red curve represents the density of the CsCl gradient with respect to the right-hand 
scale.

 • The dotted line at the top of the graph represents the concentration at which CsCl will 
precipitate.

 • The dotted line near the middle of the graph represents the initial density (1.55 g/mL) of 
the gradient.

Time required for the maximized separation is shown in the Elapsed Time (hr:min) window. You 
can use the slide bar to display separations at shorter run times. When you find the required 
separation with the shortest run time you can transfer these parameters to the Settings window 
and start the run, or save the simulation for later recall.

NOTE To save the program for future recall, press (Save) , then enter a program name in the dialog 
box. If the program is a modification of a previously saved program that you want to retain, you can 
save the new version under a different name by selecting Save As from the File menu.

5. Press (Download)  to transfer the run parameters to the Settings window. If not saved to a 
specific filename, the program is automatically saved to a temporary file called LastPlasmid.pla.

6. Press (Enter) , then (Start)  to run the program.

ESP RNA (BEST)

Two simulations are provided for the pelleting of RNA molecules in the range 0.1 to 3.0 kbp through 
a cushion of 5.7 M CsCl at 25°C in a swinging bucket rotor. The RNA (Best) simulation, of a sample 
suspended in 2.91 M CsCl containing 4 M GuSCN layered over a CsCl cushion occupying one-third of 
the tube volume, is optimized for purity.
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Figure 4.5  ESP RNA (Best) Screen

To set up an ESP RNA (Best) run:

1. Select ESP RNA Run (Best) from the Simulate menu.

2. Select the particle length.

3. Select the rotor (swinging bucket only) and tube in use.

4. Press (Simulate Protocol) .

The simulation is displayed on the graph.

 • The green and blue curves represent the relative concentration of linear and supercoiled 
DNA, respectively.

 • The red curve represents the density of the CsCl gradient with respect to the right-hand 
scale.

 • The dotted line at the top of the graph represents the concentration at which CsCl will 
precipitate.

Time required for the maximized separation is shown in the Elapsed Time (hr:min) window. You 
can use the slide bar to display separations at shorter run times. When you find the required 
separation with the shortest run time, you can transfer these parameters to the Settings 
window and start the run, or save the simulation for later recall.

NOTE To save the program for future recall, press (Save) , then enter a program name in the dialog 
box. If the program is a modification of a previously saved program that you want to retain, you can 
save the new version under a different name by selecting Save As from the File menu.

5. Press (Download)  to transfer the run parameters to the Settings window. 

6. Press (Enter) , then (Start)  to run the program. If not saved to a specific filename, the program 
is automatically saved to a temporary file called LastESPRNA(Best).rnb.
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ESP RNA (Fast)

The RNA (Fast) simulation, of a sample suspended in 4 M GuSCN without CsCl layered over a CsCl 
cushion occupying one-fourth of the tube volume, is optimized for speed.

Figure 4.6  ESP RNA (Fast) Screen

To set up an ESP RNA (Fast) run:

1. Select ESP RNA Run (Fast) from the Simulate menu.

2. Enter the particle length.

3. Select the rotor (swinging bucket only) and tube in use.

4. Press (Simulate Protocol) .

The simulation is displayed on the graph.

 • The green and blue curves represent the relative concentration of linear and supercoiled 
DNA, respectively.

 • The red curve represents the density of the CsCl gradient with respect to the right-hand 
scale.

 • The dotted line at the top of the graph represents the concentration at which CsCl will 
precipitate.

Time required for the maximized separation is shown in the Elapsed Time (hr:min) window. You 
can use the slide bar to display separations at shorter run times. When you find the required 
separation with the shortest run time, you can transfer these parameters to the Settings 
window and start the run, or save the simulation for later recall.

NOTE To save the program for future recall, press (Save) , then enter a program name in the dialog 
box. If the program is a modification of a previously saved program that you want to retain, you can 
save the new version under a different name by selecting Save As from the File menu.
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5. Press (Download)  to transfer the run parameters to the Settings window. If not saved to a 
specific filename, the program is automatically saved to a temporary file called 
LastESPRNA(Fast).rnf.

6. Press (Enter) , then (Start)  to run the program. 

Recall Simulation

You can recall previously saved simulations that you want to reuse or modify.

1. Select Recall Simulation from the Simulate menu.

2. Select the simulation you want to recall.

3. Press (Open)  to open the simulation.

4. Press (Download)  to transfer the run parameters to the Settings window.

NOTE. You can modify the program before running it, but changes will not be saved unless you save the 
altered program under a new name.

5. Press (Enter) , then (Start)  to run the program.
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CHAPTER 5

Reference and Log Functions

Reference Features

Figure 5.1  Reference Menu

The Optima™ eXPert software provides reference functions to facilitate the ultracentrifugation 
process. Among the features are:

 • A rotor catalog that lists Beckman Coulter preparative ultracentrifuge rotors by rotor type.

 • A rotor library that lists the Beckman Coulter preparative ultracentrifuge rotors available at the 
user’s site.

 • A tube catalog that provides a list of all tubes used in Beckman Coulter preparative 
ultracentrifuge rotors.

 • An interactive chemical resistances listing to provide general information about chemical 
interactions between equipment/accessories used in ultracentrifugation and various 
commonly used chemicals.

Rotor Catalog

The rotor catalog lists all Beckman Coulter preparative ultracentrifuge rotors. (Discontinued rotors 
are included in the catalog for the benefit of customers still using them—the discontinued date 
appears in the Specification area of the window.) Rotors are grouped by type:

 • swinging bucket, in which tubes are held in numbered rotor buckets attached to numbered 
positions on the rotor body

 • fixed angle, in which tubes are held at an angle (usually 20 to 45 degrees) to the axis of rotation 
in numbered tube cavities

 • near vertical tube, in which tubes are held at a reduced angle (typically 7 to 10 degrees) to the 
axis of rotation in numbered cavities; the reduced tube angle reduces run time from fixed angle 
rotors

 • vertical tube, in which tubes are held parallel to the axis of rotation
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Rotor selection depends on a variety of factors, such as sample volume, number of sample 
components to be separated, particle size, required run time, required quality of separation, type of 
separation, and the ultracentrifuge in use. General information about ultracentrifuge rotor 
selection and use is in Rotors and Tube for Beckman Coulter Preparative Ultracentrifuges (LR-IM); 
detailed information about the use and care of a specific rotor is contained in the applicable rotor 
manual.

Figure 5.2  Rotor Catalog Screen

To use the rotor catalog:

1. Select Rotor Catalog from the Reference menu. The rotor catalog lists all Beckman Coulter 
preparative ultracentrifuge rotors, grouped by rotor type. Rotors that are no longer 
manufactured have an X over the icon beside the rotor name.

NOTE To view a list of only one type of rotor, select from the Type of Rotor drop-down menu.

2. Select a rotor from the list. You can display specifications for the rotor only, or for a specific 
rotor and tube combination by pressing the applicable radio button in the Specification area.
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Figure 5.3  Selected Rotor Specifications

3. You can select a different tube that may be used with the selected rotor from the Tube drop-
down menu. The specifications for the selected tube will be displayed in the Specification area.

4. Press (Close)  to close the window.

Rotor Library

The rotor library is created by the user to list the Beckman Coulter preparative ultracentrifuge 
rotors that are available at the user’s site. Rotors in the rotor library appear in the rotor drop-down 
menu of each setup window with a rotor option. Create or edit the rotor library as follows:
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Figure 5.4  Select Rotor Screen

To add a rotor to the rotor library:

1. From the Settings screen, press the (Select Rotor)  button. The Select Rotor screen appears.

2. From the Select Rotor screen, press the (Add Rotor)  button. The Select from Rotor Catalog 
screen appears.

3. In the Rotor Catalog list to the left of the screen, select a rotor name and press the (OK)  button. 
The Enter Rotor Serial Number screen appears.

Figure 5.5  Enter Rotor Serial Number Screen
PN LXP-IM-75-4



Reference and Log Functions
Reference Features 5
4. Enter the serial number (up to 9 digits in length) on the keypad, and press the (OK)  button to 
accept. The Select Rotor screen returns to view, and the rotor type is added to the list.

5. Press the (OK)  button to close the window. The Settings screen returns to view. To add another 
rotor type, repeat Steps 1 to 5.

To delete a rotor from the rotor library:

1. From the Settings screen, press the (Select Rotor)  button. The Select Rotor screen appears.

2. From the Select Rotor screen, select a rotor type from the list and press the (Delete Rotor)  
button. The rotor type is removed from the list.

3. Press the (OK)  button to close the window. The Settings screen returns to view. To delete 
another rotor type, repeat Steps 1 to 3.

Tube Catalog

The tube catalog lists Beckman Coulter tubes used in preparative ultracentrifuge rotors. Tube 
selection depends on a variety of factors, such as sample volume, number of sample components to 
be separated, particle size, required run time, required quality of separation, type of separation, and 
the rotor and ultracentrifuge in use. General information about tube selection and use is in Rotors 
and Tubes for Beckman Coulter Preparative Ultracentrifuges (LR-IM), and tube ordering 
information is in the Ultracentrifuge Rotors, Tubes and Accessories Catalog (BR-8101, available at 
www.beckmancoulter.com). Tubes are grouped in the catalog by type—OptiSeal,™ Quick-Seal,® 
open-top, and konical.™ The tube type is indicated by an icon beside the tube name. You can view 
the specifications of a listed tube using the following procedure.

Figure 5.6  Tube Catalog
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To use the tube catalog:

1. Select Tube Catalog from the Reference menu.

2. Select a tube from the list. The specifications for the selected tube will be displayed in the Tube 
Specification area.

NOTE To view a list of only one type of tube, select from the Type of Tube drop-down menu.

Figure 5.7  Selected Tube Specifications

3. You can view a list of rotors that use the selected tube from the Compatible Rotor drop-down 
menu.

4. Press (Close)  to close the window.

Chemical Resistances

The chemical resistances list provides general information about the chemical interaction between 
equipment and accessories used in ultracentrifugation and various commonly used chemicals. A 
complete list of materials and chemicals is in Chemical Resistances (publication IN-175), available at 
www.beckmancoulter.com.

Materials that have unsatisfactory or marginal resistance to the high concentrations used for these 
tests may still be usable in very low (that is, millimolar) concentrations. Soak tests at 1 g (at 20°C) 
established the data for most of the materials; reactions may vary under the stress of centrifugation, 
or with extended contact or temperature variations. Therefore, to prevent tube or bottle failure and 
sample loss, all solution/accessory combinations should be tested under operating conditions 
before use.
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CAUTION

The information provided in the table is from references, from current literature, 
or from research done by Beckman Coulter, and is only a guide for the proper 
selection of materials. No guarantee of safety based on these recommendations 
is expressed or implied. Many of the chemicals are explosive when concentrated 
or dry, or are toxic, caustic, allergenic, or carcinogenic. Always observe proper 
handling.

To use the chemicals list:

1. Select Chemical Resistances from the Reference menu.

2. Press the (Chemicals)  button to see a list of all chemicals represented in the database, or select 
a subset of chemicals to be displayed from the Type of Chemical drop-down menu.

Figure 5.8  Chemicals/UPAC Name Screen

The chemicals are listed alphabetically by their most common name. Where applicable an 
IUPAC (International Union of Pure and Applied Chemistry) name is shown to the right of a 
trivial chemical name. Chemicals listed are either undiluted liquids or saturated (unless 
otherwise noted) aqueous solutions.

3. Select a chemical from the list and press (OK) . 

4. Select the appropriate tab for the category of ultracentrifugation accessory (Tubes; Caps, 
Spacers, Rotors; O-Rings, Adapters, Seals; Tubing; Finishes).
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Figure 5.9  Chemical Resistances Screen

Materials within the selected category are listed, together with the symbol for the material’s 
chemical resistance to the selected chemical. Explanation of the symbols is shown in the area 
to the right of the list.

5. Press the (Chemicals)  button to select another chemical or press (Close)  to close the window.

Exporting Data

Figure 5.10  Optima L-XP Control Head with USB Hub
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The ultracentrifuge automatically saves data associated with each run that may be exported to a 
memory device. The memory device is connected to the USB port on the top of the instrument 
Control Head. The exported data may be opened in a spreadsheet program such as Microsoft Excel. 
To optimize instrument performance, it is recommended that you periodically export the data and 
delete data files.

NOTE You must have an external memory device connected to the USB port before attempting to 
export data.

To export data:

1. On the Settings screen, select Export Data from the Optima L-XP drop-down menu. The Export 
Data screen appears.

Figure 5.11  Export Data Screen

2. Enter a file name up to 20 characters in length on the keypad. Uppercase letters are default. To 
enter lowercase letters, press the (Shift)  key. Press (Back)  to erase entered characters one at a 

time. To clear the entire entry, press (Clear) .

3. Press the (Clear)  button. The Export Data screen closes when the export is complete, after 
which the memory device can be safely removed from the USB port.

Log Features

Figure 5.12  Logs Menu
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The Logs menu provides access to the Instrument Usage Log, Display Last Run Record log, and the 
Print Last Run Record Automatically option.

Instrument Usage Log

Instrument usage is logged during each ultracentrifuge run. Each Instrument Usage Log includes 
the user name and date, the time the run was started, the type of run, the name of the program, the 
rotor ID and serial number, the stop condition (run completed, stopped by operator, or stopped by 
diagnostic), maximum speed reached (in rpm), total run time (a multistep run is considered one 
run; maximum speed and total run time for all steps is given), total ω2t, the rotor temperature at 
the end of the run, run comments for batch and lot information, and the acceleration and 
deceleration profiles for the run. The log may be printed out; see CHAPTER 2, Preinstallation 
Requirements, for printer hookup instructions.

To print an instrument usage log:

1. Select Instrument Usage Log from the Logs menu.

2. Select Print from the File menu to print the entire log, or select a run and press (View Details) , 
then select Print to print a specific run.

Display Last Run Record

Complete run information is logged when the run ends (a multistep run is considered one run), and 
is viewed by selecting Display Last Run Record. The run record includes the user name, rotor ID, 
free-text comments, and diagnostic codes. This log may be printed to maintain a permanent record 
for regulatory or lab processes purposes. You can have each run record automatically printed upon 
run completion by selecting Print Last Run Record Automatically from the Logs menu (see 
CHAPTER 2, Preinstallation Requirements, for printer hookup instructions).

NOTE The settings for a run are logged when the run starts.
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Figure 5.13  Run Record
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CHAPTER 6

Troubleshooting

Introduction

This chapter lists possible malfunctions, together with probably causes and corrective actions. 
Maintenance procedures are given in CHAPTER 7, Maintenance. For any problems not covered here, 
contact Beckman Coulter Field Service (1-800-742-2345 in the United States; worldwide offices are listed on 
the back cover of this manual) for assistance.

NOTE It is your responsibility to decontaminate the instrument, as well as any rotors and/or accessories, 
before requesting service by Beckman Coulter Field Service.

User Messages

Informational messages and setup prompts are displayed in the Status window or on the status line 
at the screen bottom. If an abnormal condition arises, a Diagnostics window appears. The problem 
and a recommended corrective action are displayed in the window. After correcting the problem, 
press (Clear)  to clear the diagnostic and close the window. (The message will reappear if the 
problem still exists.)

If the message provides cautionary information only, the run continues uninterrupted. For 
example, if the speed setting is higher than the speed permitted by the rotor overspeed disk, the 
speed will be lowered to the maximum rated speed and a diagnostic message will indicate that the 
change has been made. If a serious problem arises, the instrument will shut down with or without 
the brake, depending on the problem. If necessary, the power will automatically trip. Corrective 
action will be displayed.

Refer to Table 6.1 to determine the nature of the condition and any recommended actions. If a 
problem persists after you have performed the recommended action, call Beckman Coulter Field 
Service (in the United States, call 1-800-742-2345; outside the U.S., call your local Beckman Coulter 
office).
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Retrieving Your Sample in Case of Power Failure

If a power failure occurs during a run, the rotor begins to decelerate with the brake off. If the rotor 
is still spinning above 1 000 rpm when power is restored, the instrument will resume operation and 
the rotor will return to set speed. A diagnostic message will alert you that a power outage occurred.

Table 6.1  Diagnostic Message Chart

Diagnostic Category/
Range

Possible Cause User Action

SPEED
3X

Speed has been set above maximum 
allowed; or wrong, damaged, or missing 
overspeed disk

Check set speed; check for clean, 
undamaged, and correct 
overspeed disk (see Rotors and 
Tubes for replacement 
instructions).

TEMPERATURE
5X

Temperature control or vacuum system 
malfunctioning

Check the air inlet (at bottom of 
the front panel) for obstructions. 
Call Beckman Coulter Field 
Service.

DRIVE
6X

Abnormal change in drive speed or 
overheated drive

Be sure a rotor is properly installed 
on the spindle; if power has failed, 
wait for 5 minutes for drive to cool; 
check for air inlet obstruction.

VACUUM
4X

Vacuum not being drawn properly Check door O-ring for damage and 
cleanliness; check for excessive 
moisture; turn the vacuum on for a 
few hours or overnight; check rotor 
lid O-rings for possible leakage.

IMBALANCE
7X

Rotor imbalance (at low speeds) Check for proper rotor loading.

DOOR
8X

Door is open when the (Start)  key is 
pressed

Be sure door is closed.

POWER
2X

Loss of power during run Check TIME display; Run may need 
to be restarted or aborted.

CPU
1X or 9X

Microprocessor malfunction or loss of 
program memory

No user action. Call Beckman 
Coulter Field Service.

COMM Communication lost between the user 
interface and the instrument control

No user action. Call Beckman 
Coulter Field service.

There is no default printer set when 
Automatically Print a Run Record was 
selected

Set up printer under File menu.
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If the rotor is spinning below 1 000 rpm when power is restored,

 • In TIME mode, the timer resets to the original time setting and starts counting down.

 • In HOLD mode, the timer resets to zero and starts counting up.

 • In ESP or multi-step mode, the system repeats the step during which the power failure 
occurred, from the beginning of that step.

If a power failure lasts for several hours, it may be necessary to retrieve the sample from the rotor. 
(A rotor decelerating without the brake may take hours to come to a complete stop.) To gain access 
to the rotor, it will be necessary to remove the control head cover and front panel to disengage the 
door lock.

WARNING

Any maintenance procedure requiring removal of a panel exposes the operator to 
the possibility of electrical shock and/or physical injury. Therefore, turn the power 
OFF and disconnect the instrument from the main power source, and refer such 
maintenance to service personnel.

WARNING

NEVER attempt to slow or stop the rotor by hand.

WARNING

The following procedure should be performed only when absolutely necessary and 
only by qualified service personnel.

To remove a sample upon power failure:

1. Remove the key from the key switch and turn the power switch to off position before trying to 
slide the control head cover off the instrument.

2. Locate the two metal latches (see Figure 6.1) at the lower outside corners on the back of the 
control head. Use your fingers to depress the latches to disengage the cover from the control 
head. 

3. With both hands, lift it slightly and pull it toward you, until it is free (approximately 1 to 
1 1/2 inches), taking care not to disconnect or damage any of the attached cables.

4. To open the top cover, insert a #2 (0.25-inch diameter) Phillips-head screwdriver into the hole 
located in the front, center of the top cover (see Figure 6.2). Turn the screwdriver 
counterclockwise (to the left) until the screw bottoms out. Then, to release the latch, push the 
screwdriver inward. Once the latch is released, lift the top cover.

5. Lift the front panel to free the bottom tabs that secure it in place.
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NOTE In Figure 6.1, the control head is shown separated from the instrument, and attached wires are 
not shown to provide detail of latches.

Figure 6.1  Removing the Control Head Cover

Access to
Cover Latch

Access to
Cover Latch

Cover Latch
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WARNING

After removing the panel, listen carefully for any sounds coming from the drive. 
Then touch the fan housing (see Figure 6.3) to feel if it is vibrating and listen 
again. Do not proceed if any sound or vibration is emitted from the housing.

Figure 6.2  Depressing the Latch to Loosen the Front Panel

6. Vent the vacuum chamber by slowly turning the small setscrew on the vacuum solenoid valve 
to the right (clockwise) as shown in Figure 6.3 until you hear the air released into the chamber. 
If you hear a whining noise, close the valve and wait, because the rotor is still spinning.

7. About 10 seconds after the hissing noise stops, turn the setscrew to the left (counterclockwise) 
until it stops.

8. Push down on the interlock pin with your finger (Figure 6.3) while opening the chamber door 
with your free hand. (If the rotor is still spinning, close the door and wait.) Be very careful not 
to touch any wires or circuitry.

Front Panel Tabs 

Top Panel Tabs 

Front Panel Access Port 
PN LXP-IM-7 6-5



Troubleshooting
Retrieving Your Sample in Case of Power Failure 
WARNING

Do not attempt to run the instrument before returning the front panel and control 
head cover to the correct position.

Figure 6.3  Interior View of Instrument (Panel Removed)

9. After retrieving the sample, close the chamber door, then replace the front panel on the 
instrument. Insert the tabs at the bottom of the panel onto the lip at the base of the instrument, 
being sure to align the front panel with the side panels. (See Figure 6.4)

Figure 6.4  Reinstalling the Front Panel
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10. Lift the front edge of the top panel a few inches and insert the upper edge of the front panel 
under it. Push back gently to engage the tabs, then down to activate the latch.

11. Carefully replace the control head by sliding it along the small ridges provided. When the 
control head cover is correctly positioned, push it until the latches snap into place.

12. Return the key to the interlock switch.
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CHAPTER 7

Maintenance

Introduction

This chapter contains care and maintenance procedures that should be performed regularly. For 
maintenance not covered in this manual, contact Beckman Coulter Field Service (1-800-742-2345 in the 
United States; worldwide offices are listed on the back cover of this manual) for assistance. User messages 
and recommended actions are discussed in CHAPTER 6, Troubleshooting. Refer to the applicable rotor 
manual and Rotors and Tubes for instructions on the care of rotors and their accessories.

NOTE It is your responsibility to decontaminate the instrument, as well as any rotors and/or accessories, 
before requesting service by Beckman Coulter Field Service.

WARNING

Any maintenance procedure requiring removal of a panel exposes the operator to 
the possibility of electrical shock and/or physical injury. Therefore, turn the power 
OFF and disconnect the instrument from the main power source, and refer such 
maintenance to service personnel.

Cleaning

NOTE Before using any cleaning or decontamination methods except those recommended by the 
manufacturer, users should check with the manufacturer that the proposed method will not damage 
the equipment.

Clean instrument surfaces using a cloth dampened with a mild detergent solution such as Beckman 
Solution 555™. (Be careful not to spill liquid on the instrument where electrical or mechanical 
components could get damaged.)
PN LXP-IM-7 7-1



Maintenance
Decontamination 
Rotor Chamber

The rotor chamber is coated with epoxy resin paint, and the chamber door O-ring is Buna N rubber. 
The chamber can be wiped clean with a cloth dampened with a mild detergent such as Solution 555. 
The O-ring should be cleaned with a tissue or soft cloth every 3 or 4 months. Replace the O-ring 
whenever it becomes worn or damaged. Lightly coat the O-ring with silicone vacuum grease 
(335148) before reinstalling it to ensure an optimum vacuum seal. (Instrument O-rings have not 
been designed as bioseals for aerosol containment.)

Decontamination

If the instrument and/or accessories are contaminated with radioactive or pathogenic solutions, 
follow appropriate decontamination procedures as determined by your laboratory safety officer. 
Refer to the chemical resistances list or contact Beckman Coulter Field Service to ensure that the 
decontamination method does not damage any part of the instrument (or accessories).

Sterilization and Disinfection

The top working surface is finished with urethane paint; the sides are finished with general purpose 
paint. Ethanol (70%)* may be used on both these surfaces.

While Beckman Coulter has tested these methods and found that they do not damage the 
instrument, no guarantee of sterility or disinfection is expressed or implied. When sterilization or 
disinfection is a concern, consult your laboratory safety officer regarding proper methods to use.

Storage and Transportation

To ensure that the instrument does not get damaged, contact Beckman Coulter Field Service for 
specific instructions and/or assistance in preparing the equipment for transport or long-term 
storage. Temperature and humidity requirements for storage should meet the environmental 
requirements described under Specifications in CHAPTER 1, Description, of this manual.

* Flammability hazard. Do not use in or near operating ultracentrifuges.
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Supply List

Contact Beckman Coulter Sales (1-800-742-2345 in the United States; worldwide offices are listed on 
the back cover of this manual) for information about ordering parts and supplies. A partial list of 
supplies is given below for your convenience. See the Beckman Coulter Ultracentrifuge Rotors, Tubes 
& Accessories catalog (BR-8101, available at www.beckmancoulter.com) for detailed information on 
ordering rotors, tubes, and accessories.

Replacement Parts

Supplies

Description Part Number

Chamber O-ring 801778

Hewlett-Packard Deskjet 940c Printer 963423

Description Part Number

Spinkote lubricant (1 oz) 306812

Silicone vacuum grease (2 oz) 335148

Beckman Solution 555 (1 qt) 339555

Logbook for preparative ultracentrifuges 330049

Master rotor logbook 339587
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APPENDIX A

Remote Access

Introduction

This appendix contains information on how to enable the use of the Remote Access feature.

NOTE To enable the Remote Access feature, the ultracentrifuge must be connected to a Local Area Network 
(LAN) via the ethernet port.

The Remote Access feature provided with the Optima™ L-XP eXPert operating software allows for 
remote access and operation of the Optima L-XP ultracentrifuge using a computer running Virtual 
Networking Computing (VNC) software. Most of the VNC applications available for download are 
freeware and all are acceptable for use with the Optima™ L-XP eXPert operating software.

NOTE Technical support for the VNC software is not provided by Beckman Coulter Field Service. This 
appendix is intended to provide instructions on the use of the Optima™ L-XP eXPert operating software 
to enable a connection with the VNC client. Refer to the technical support policy for the VNC software in 
use.

Follow the directions provided with the VNC software for proper configuration. The Internet 
Protocol (IP) address of the Optima L-XP ultracentrifuge is needed to connect the VNC software to 
the ultracentrifuge. The IP address is obtained by using the following procedure.
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Figure A.1  About Optima L-XP Screen

To enable remote access:

1. On the Settings screen, select About Optima L-XP from the Optima L-XP drop-down menu. The 
About Optima L-XP screen appears.

2. From the About Optima L-XP screen, write down the IP address that is listed above the 
copyright disclaimer.

3. Press the (OK)  button to close the About Optima L-XP screen.

4. Follow the directions provided with the VNC software to enter the IP address and to remotely 
access the ultracentrifuge.

Once connected, the ultracentrifuge can be controlled using the computer’s keyboard and mouse.

NOTE Two buttons on the control panel of the ultracentrifuge are mapped to the computer keyboard when 
using the Remote Access feature. The F7 key on the computer keyboard activates the Vacuum and the 
F8 key activates the Stop button. Some VNC software packages use the F8 key to display a menu. Consult 
the VNC software documentation for instructions to configure the F8 key or shift this menu command to 
a different key.

When finished using the ultracentrifuge, follow the directions provided with the VNC software to 
close the remote connection.

VNC License Information

The Optima™ L-XP eXPert operating software contains VNC Free Edition 4.1.2 by RealVNC Ltd. VNC 
Free Edition is covered by the GNU General Public License, Version 2. VNC Free Edition 4.1.2 is 
redistributed within this product in unmodified binary form. Beckman Coulter, Inc. holds the 
source code for VNC Free Edition 4.1.2 as required by the GNU General Public License, Version 2, and 
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provides said source code at no cost. To obtain a copy of the source code for VNC Free Edition 4.1.2 
at no cost, please contact Beckman Coulter Technical Support.

Inclusion of VNC Free Edition 4.1.2 into the Optima L-XP ultracentrifuge is an aggregation as 
specified by the GNU General Public License, Version 2. As such, the GNU General Public License, 
Version 2, applies only to the VNC Free Edition components included with this ultracentrifuge.

GNU General Public License, Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 
02111-1307, USA. Everyone is permitted to copy and distribute verbatim copies of this license 
document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By 
contrast, the GNU General Public License is intended to guarantee your freedom to share and 
change free software--to make sure the software is free for all its users. This General Public License 
applies to most of the Free Software Foundation’s software and to any other program whose authors 
commit to using it. (Some other Free Software Foundation software is covered by the GNU Library 
General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses 
are designed to make sure that you have the freedom to distribute copies of free software (and 
charge for this service if you wish), that you receive source code or can get it if you want it, that you 
can change the software or use pieces of it in new free programs; and that you know you can do 
these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or 
to ask you to surrender the rights. These restrictions translate to certain responsibilities for you if 
you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give 
the recipients all the rights that you have. You must make sure that they, too, receive or can get the 
source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license 
which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands 
that there is no warranty for this free software. If the software is modified by someone else and 
passed on, we want its recipients to know that what they have is not the original, so that any 
problems introduced by others will not reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger 
that redistributors of a free program will individually obtain patent licenses, in effect making the 
program proprietary. To prevent this, we have made it clear that any patent must be licensed for 
everyone’s free use or not licensed at all.
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The precise terms and conditions for copying, distribution and modification follow.

GNU General Public License Terms and Conditions for Copying, Distribution 
and Modification

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in 
any medium, provided that you conspicuously and appropriately publish on each copy an 
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer 
to this License and to the absence of any warranty; and give any other recipients of the Program 
a copy of this License along with the Program. You may charge a fee for the physical act of 
transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work 
based on the Program, and copy and distribute such modifications or work under the terms of 
Section 1 above, provided that you also meet all of these conditions:

a. You must cause the modified files to carry prominent notices stating that you changed the 
files and the date of any change.

b. You must cause any work that you distribute or publish, that in whole or in part contains 
or is derived from the Program or any part thereof, to be licensed as a whole at no charge 
to all third parties under the terms of this License.

c. If the modified program normally reads commands interactively when run, you must cause 
it, when started running for such interactive use in the most ordinary way, to print or 
display an announcement including an appropriate copyright notice and a notice that 
there is no warranty (or else, saying that you provide a warranty) and that users may 
redistribute the program under these conditions, and telling the user how to view a copy 
of this License. (Exception: if the Program itself is interactive but does not normally print 
such an announcement, your work based on the Program is not required to print an 
announcement.

These requirements apply to the modified work as a whole. If identifiable sections of that work 
are not derived from the Program, and can be reasonably considered independent and separate 
works in themselves, then this License, and its terms, do not apply to those sections when you 
distribute them as separate works. But when you distribute the same sections as part of a whole 
which is a work based on the Program, the distribution of the whole must be on the terms of 
this License, whose permissions for other licensees extend to the entire whole, and thus to each 
and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written 
entirely by you; rather, the intent is to exercise the right to control the distribution of derivative 
or collective works based on the Program.

0. This License applies to any program or other work which contains a notice placed by the 
copyright holder saying it may be distributed under the terms of this General Public License. 
The “Program”, below, refers to any such program or work, and a “work based on the 
Program” means either the Program or any derivative work under copyright law: that is to 
say, a work containing the Program or a portion of it, either verbatim or with modifications 
and/or translated into another language. (Hereinafter, translation is included without 
limitation in the term “modification”.) Each licensee is addressed as “you”.
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In addition, mere aggregation of another work not based on the Program with the Program (or 
with a work based on the Program) on a volume of a storage or distribution medium does not 
bring the other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code 
or executable form under the terms of Sections 1 and 2 above provided that you also do one of 
the following:

a. Accompany it with the complete corresponding machine-readable source code, which 
must be distributed under the terms of Sections 1 and 2 above on a medium customarily 
used for software interchange; or,

b. Accompany it with a written offer, valid for at least three years, to give any third party, for 
a charge no more than your cost of physically performing source distribution, a complete 
machine-readable copy of the corresponding source code, to be distributed under the 
terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

c. Accompany it with the information you received as to the offer to distribute corresponding 
source code. (This alternative is allowed only for noncommercial distribution and only if 
you received the program in object code or executable form with such an offer, in accord 
with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to 
it. For an executable work, complete source code means all the source code for all modules it 
contains, plus any associated interface definition files, plus the scripts used to control 
compilation and installation of the executable. However, as a special exception, the source code 
distributed need not include anything that is normally distributed (in either source or binary 
form) with the major components (compiler, kernel, and so on) of the operating system on 
which the executable runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated 
place, then offering equivalent access to copy the source code from the same place counts as 
distribution of the source code, even though third parties are not compelled to copy the source 
along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided 
under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program 
is void, and will automatically terminate your rights under this License. However, parties who 
have received copies, or rights, from you under this License will not have their licenses 
terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else 
grants you permission to modify or distribute the Program or its derivative works. These 
actions are prohibited by law if you do not accept this License. Therefore, by modifying or 
distributing the Program (or any work based on the Program), you indicate your acceptance of 
this License to do so, and all its terms and conditions for copying, distributing or modifying the 
Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient 
automatically receives a license from the original licensor to copy, distribute or modify the 
Program subject to these terms and conditions. You may not impose any further restrictions on 
the recipients’ exercise of the rights granted herein. You are not responsible for enforcing 
compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other 
reason (not limited to patent issues), conditions are imposed on you (whether by court order, 
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agreement or otherwise) that contradict the conditions of this License, they do not excuse you 
from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your 
obligations under this License and any other pertinent obligations, then as a consequence you 
may not distribute the Program at all. For example, if a patent license would not permit royalty-
free redistribution of the Program by all those who receive copies directly or indirectly through 
you, then the only way you could satisfy both it and this License would be to refrain entirely 
from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular 
circumstance, the balance of the section is intended to apply and the section as a whole is 
intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right 
claims or to contest validity of any such claims; this section has the sole purpose of protecting 
the integrity of the free software distribution system, which is implemented by public license 
practices. Many people have made generous contributions to the wide range of software 
distributed through that system in reliance on consistent application of that system; it is up to 
the author/donor to decide if he or she is willing to distribute software through any other 
system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the 
rest of this License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents 
or by copyrighted interfaces, the original copyright holder who places the Program under this 
License may add an explicit geographical distribution limitation excluding those countries, so 
that distribution is permitted only in or among countries not thus excluded. In such case, this 
License incorporates the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public 
License from time to time. Such new versions will be similar in spirit to the present version, but 
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version 
number of this License which applies to it and “any later version”, you have the option of 
following the terms and conditions either of that version or of any later version published by 
the Free Software Foundation. If the Program does not specify a version number of this License, 
you may choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution 
conditions are different, write to the author to ask for permission. For software which is 
copyrighted by the Free Software Foundation, write to the Free Software Foundation; we 
sometimes make exceptions for this. Our decision will be guided by the two goals of preserving 
the free status of all derivatives of our free software and of promoting the sharing and reuse of 
software generally.
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NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE 
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE 
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE 
PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, 
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY 
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE 
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY 
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA 
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A 
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH 
HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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Special Warranty for the Optima™ L, LE, L-XP,
and XL Preparative Ultracentrifuges

Subject to the exceptions and upon the conditions specified below, Beckman Coulter, Inc., agrees to 
correct, either by repair, or, at its election, by replacement, any defects of material or workmanship 
which develop within one (1) year after delivery of the Optima Ultracentrifuge (the product), to the 
original Buyer by Beckman Coulter, or by an authorized representative, provided that investigation 
and factory inspection by Beckman Coulter discloses that such defect developed under normal and 
proper use.

Some components and accessories by their nature are not intended to and will not function for as 
long as one (1) year. If any such component or accessory fails to give reasonable service for a 
reasonable period of time, Beckman Coulter will repair or, at its election, replace such component 
or accessory. What constitutes either reasonable service and a reasonable period of time shall be 
determined solely by Beckman Coulter.

Replacement
Any product claimed to be defective must, if requested by Beckman Coulter be returned to the 
factory, transportation charges prepaid, and will be returned to Buyer with the transportation 
charges collect unless the product is found to be defective, in which case Beckman Coulter will pay 
all transportation charges.
Beckman Coulter makes no warranty concerning products or accessories not manufactured by it. In 
the event of failure of any such product or accessory, Beckman Coulter will give reasonable 
assistance to the Buyer in obtaining from the respective manufacturer whatever adjustment is 
reasonable in light of the manufacturer’s own warranty.
Damage to the instrument while operating a rotor not of Beckman Coulter manufacture is not 
covered by warranty or service contract terms. Further, Beckman Coulter shall be released from all 
obligations under all warranties either expressed or implied, if the product covered hereby is 
repaired or modified by persons other than its own authorized service personnel, unless such repair 
is made by others who meet qualifications similar to those required of Beckman Coulter’s service 
personnel, or unless such repair in the sole opinion of Beckman Coulter is minor, or unless such 
modification is merely the installation of a new Beckman Coulter plug-in component for such 
product.

Special Drive Warranty
During the instrument warranty period (one year), there will be no charge for drive replacement if 
the drive unit is installed, serviced, and operated in accordance with the conditions listed below. 
During the drive’s second through tenth year of use there is a prorated drive replacement price 
based on years of use if the drive unit is installed, serviced, and operated in accordance with the 
conditions listed below.

Drive replacement price for units not under service contract* = current drive exchange price

Conditions

1. The drive has been operated only within its rated speed and temperature ranges.

* For details of drive coverage with a service contract, contact your local Beckman Coulter service representative.

× years of use
10

----------------------------〈 〉 labor and  travel.+
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Special Warranty for the Optima™ L, LE, L-XP, and XL Preparative Ultracentrifuges
2. The drive unit has not been subjected to unequal loading, improper rotor installation, corrosion 
from material spilled onto the hub or accumulated in the chamber of the instrument.

3. The drive unit has not been disassembled, modified, or repaired, except by Beckman Coulter 
personnel.

4. The drive unit was installed by a Beckman Coulter Field Service representative.

5. The instrument in which the drive unit has been used and operated, and its associated rotors, 
were manufactured by Beckman Coulter and serviced only by Beckman Coulter Field Service 
representatives.

If the above conditions are not met, the full appropriate exchange price for the drive will be 
charged.

Disclaimer
IT IS EXPRESSLY AGREED THAT THE ABOVE WARRANTY SHALL BE IN LIEU OF ALL 
WARRANTIES OF FITNESS AND OF THE WARRANTY OF MERCHANTABILITY AND THAT 
BECKMAN COULTER, INC. SHALL HAVE NO LIABILITY FOR SPECIAL OR CONSEQUENTIAL 
DAMAGES OF ANY KIND WHATSO-EVER ARISING OUT OF THE MANUFACTURE, USE, SALE, 
HANDLING, REPAIR, MAINTENANCE, OR REPLACEMENT OF THE PRODUCT.
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